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Loading
1. Open the Load Window (Menu>File>Load Sequence or Ctrl+L)

How to Load an
Image Sequence
into track X

2. Click on the Browse button for track X
3. Navigate the file systems to find your sequence and select any frame, click ok.
4. Click the Start Button in the Load Window
OR
1. Drag and drop a single file from the sequence into the viewport. The sequence
will be loaded into whatever track is assigned to that viewport. If the Load
Window is open, only the preview will be loaded until you click the START
button.
OR
1. Drag and drop a folder into the viewport. The first sequence found will be
loaded into whatever track is assigned to that viewport. If the Load Window is
open, only the preview will be loaded until you click the START button.
OR
1. Drag and drop a single file or folder into a track in the main window.

How to load only a
certain range of an
image sequence

1. Follow steps 1 through 3 of How to Load an Image Sequence into track X on
p2
2. Drag the In and Out sliders in the corresponding track in the Load Window

3. Click the Start Button in the Load Window

3

Q U I C K

S T A R T

G U I D E

J E F E C H E C K

1. Follow steps 1 through 3 of How to Load an Image Sequence into track X on
p2.

How to Load a
Sequence as a
lower res proxy

2. Before pressing Start, select or type in a scale in the Scale Box for the sequence
you are loading, select the filtering you want to apply when resizing the image
(linear=fast, bilinear=better looking) .
3. Click the Start Button in the Load Window
OR
1. Drag and drop a a single file from the sequence into the viewport while pressing
the shift key. The sequence will be loaded into whatever track is assigned to that
viewport at 50%. If the Load Window is open, only the preview will be loaded
until you click the START button.

How to Load Y
number of
sequences into
several tracks

1. Follow steps 1 through 3 of How to Load an Image Sequence into track X on
p2 with up to four tracks (A, B, C and D).
2. Click the Start Button in the Load Window

How to load only a
specific region of
an image
sequence.

1. Follow steps 1 through 3 of How to Load an Image Sequence into track X.on
on p2
2. Activate the Crop Checkbox for that track in the Load Window
3. Select the region you wish to load on the preview image shown in the Main
Window. Click and Drag to move the Crop Region, Click and Drag the
white corner markers to resize the Crop Region. You can zoom and pan
with the left mouse button and mouse wheel.
4. Click the Start Button in the Load Window
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Note that this will store images in 16 bit in memory, allowing greater precision
when modifying 16 bit per component images with JefeCheck’s FXs at the
cost of double the memory usage. (you don’t need to do this to simple load
and playback 16bit per component images, ONLY do it if you are
experiencing problems when doing heavy processing)

How to Load an
image with 16 bit
floating point
precision

1. Follow steps 1 through 3 of How to Load an Image Sequence into track X.on
on p2
2. Select Half Float or 16bpc from the Format Option Box in the Load Window.

3. Click the Start Button in the Load Window

How to cancel
loading of a
sequence

1. Click on the white X stop button next to the track in the Main Window. The X

How to start
loading a
sequence from a
certain point in the
timeline

1.

button will only be enabled when a track is being loaded.

on the timeline to start reloading all tracks from that point
forward. This is useful when you need to check a very long sequence but are
not sure where the frames that you are interested in start and you can not fit
the whole sequence into RAM.

Alt+Left Click

OR
2. Press alt+I to set the IN point for the timeline and start loading all tracks at
that point.
OR
3.

Alt+Left Click

point forward.

on a specific track to start loading only that track from that

5

Q U I C K

S T A R T

G U I D E

J E F E C H E C K

Playback
Change the layout
of the viewports

1. Click on any of the layout radio buttons in the Main Window’s Control Bar.
Or use keyboard keys 1 through 4 while holding the ctrl key to go through
the different layouts.

How to change
what track is
displayed on each
viewport

1. Select the track you want to show (A,B,C or D) in the corresponding
viewport’s Track Option Box in the Main Window’s Control Bar.
OR
2. Press keyboard keys 1 through 4 to select tracks A through D
OR
3. Press keyboard keys up or down to move through the tracks.

How transform a
viewport

1. Left click and drag on a viewport to pan.
2. Use the mouse wheel to zoom in and out. Pressing shift while zooming makes
the zoom 10x slower OR ctrl+left click drag up and down for the same effect.
3. If you press the alt key while doing any of this, transformations will apply to all
viewports (Gang Transformation).
4. If you don’t have a mouse wheel, you can zoom in and out by clicking and
dragging the viewport’s zoom box on the Main Window’s control panel. From
this box you can also change the pan values.
5. You can also flip and flop the image by clicking on the flip and flop buttons.

6. You can reset the transformation on a viewport by pressing ctrl+r on your
keyboard, or alt+r to reset all viewports.
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1. Select a LUT from the LUT listbox or press
key..

How to color
correct a viewport
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Up/Down while holding the L

2. Adjust Gamma by inputting a value in the Gamma box or
mouse left/right while holding the W key.

Dragging the

3. Adjust Exposure by inputting a value in the Exposure box or
mouse left/right while holding the E key.

Dragging the

4.

Adjust Brightness by inputting a value in the Brightnessbox or Dragging the
mouse left/right while holding the Q key.

5. Adjust Contrast by inputting a value in the Contrast box or
mouse left/right while holding the D key.

Dragging the

6. Adjust Saturation by inputting a value in the Saturation box or Dragging the
mouse left/right while holding the S key.
7. You can reset the color correction on a viewport by pressing
keyboard, or alt+shift+r to reset all viewports.

shft+r

on your

8. You can also save a favorite color correction by pressing ctrl+shift + 1,2,3,4 or
5 . Apply the color correction to anoher viewport at another time by pressing
shift+1,2,3,4 or 5.
OR
1. Apply one or more FXs like Primary Color Correction, Brightness-ContrastSaturation, Gamma, etc.

How to change the
aspect ratio of a
viewport

1. Select or type in an aspect ratio in the viewport’s Ratio Option Box. File is the
default value, which maintains the original aspect ratio of the image.

2. You can change the aspect ratio of the image by placing black crop bars
instead of deforming it by clicking the Crop Bars Button to the left of the
Ratio Option Box.
3. Change the opacity of the crop bars in the View Menu
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How to see the
RGBA channels on
a viewport

1. Toggle through the RGBA channels by pressing the RGB button, or use

How to control the
playback

1. Click on the play/pause, rewind, fast forward, back one frame and forward
one.

shortcut keys R,G,B,A.

2. Scrub the timeline by clicking and dragging the current frame notch on the
timeline or shift clicking and dragging on the viewport.
3.

How to offset a
track on the
timeline

Click on the Playback Mode Radio Buttons to control if you want to play the
sequence once (Once) (shortcut 8), Loop it (Loop) (shortcut 9),, or play it
back and forth (Swing) (shortcut 10),

1. Click on the more options menu button (or right click on the track) next to the
track on the Main Window’s Control Bar
2. Change the value of the track offset in the More Options Window for that
track. You can type in a number or click and drag to change the value.
OR
1. Click and drag the track to move it left or right

How to hold a
specific frame on a
track

1. Click on the more options menu button next to
the track on the Main Window’s Control Bar
2. Select an option from the

Hold Frame Option

Box:

a.

Current: Holds the current frame

b.

edge: When the current frame number is smaller than the first loaded
frame on the track, the first frame will be shown. When the current
frame number is bigger than the last loaded frame on the track, the last
frame will be shown

c.

None: The track plays normally.
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1. Click on the more options menu button next to the track on the Main
Window’s Control Bar
2. Click on the Unload Track button.
OR
1. Click on the unload track from the Load Window.

How to show or
hide text
information

1. Press the shortcut key t to toggle display of information text on the viewport,
or press alt+t to toggle it on all viewports
2. If the track has a DPX, EXIF or OpenEXR metadata, it will be shown.

How to show DPX
Metadata on the
viewport

1. If the track has a DPX image sequence loaded, you can display the DPX
metadata for each frame by pressing the shortcut key t until the appropriate
text display mode is activated (text display modes are none, normal and
normal+metadata).

Processing
How to Load a
JefeCheck FX

1. Open the FX Manager Window (F3 or menu>dialogs>FX Manager).
2. Click the Browse Button
3. Select one or more .jfx files
4. If you want to have the FX autoload next time you start JefeCheck, click on
the auto-load checkbox next to the FX’s name (on by default).

How to Load a LUT

1. Open the LUT Manager Window (F4 or menu>dialogs>LUT Manager).
2. Click the Browse Button
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3. Select a .cube, .cub, .lut, or

.tga file.

4. If you want to have the LUT load automatically next time you start JefeCheck,
click on the auto-load checkbox next to the LUT’s name (on by default).

How to apply one
or more FXs to a
viewport’s FX
stack

1. Open the FX Control Window (F2 or menu>dialogs>FX Stack Manager)
2. Click on the Viewport where you want to apply the FX
3. Select the FX you want to apply from the Available FXs menu in the FX Stack
Manager Window.
4. Turn the FX on or off by clicking on the on/off checkbox on the FX’s
controls.
5. Repeat steps 3 and 4 for each FX you want to add.

How to change the
position of an FX
in the FX stack

1. Click on the Up

or Down

button on the FX’s controls.

Remote Session
How to start a
JefeCheck Remote
Session Server

1. Open the Remote Session Manager Window (F6

or menu>Remote

Session>Session Manager).

2.

In the Start Server section of the Manager fill in the necessary information:
a. Type the server’s name in the Server Name Text Box
b. Type the port the server should listen on (32000 and above
recommended) in the Port Text Box
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c. Type a password in the Password Text Box (optional but
recommended)
3. Click the Start Button

How to join a
JefeCheck Remote
Session Server

1. Open the Remote Session Manager Window (F6

or menu>Remote

Session>Session Manager).

2.

In the Connect to
information:

Server section of the Manager fill in the necessary

a. Type the server’s IP address
b. Type the port where the server you are connecting to is listening
c. Type a password in the Password if the server requires one
d. Type in a Nickname to identify yourself in the session
3. Click the Connect Button

How to Chat in a
Remote Session

1. Connect to a Remote Session
2. Press y to go into Chat Mode
3. Type in your message
4. Press enter to send the message.
5. You can also navigate the previous messages by pressing up or down on the
cursor keys on your keyboard.
6. You can exit chat mode by pressing the Escape key
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How to use
Remote Pointers in
a Remote Session

1. Connect to a Remote Session

How to Save a
Chat from a
Remote Session

1. Connect to a Remote Session

2.

J E F E C H E C K

Right Click and drag anywhere on the viewport’s area, everybody will see your
cursor with your Nickname next to it.

2. Chat
3. When you are finished, click on menu>File>Save Chat Log
4. Select where you want to save your session and type a filename

